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Symbol Definitions 

The following table lists the symbols used in this document to denote certain conditions. 

Symbol Definition 

ATTENTION: Identifies information that requires spe-
cial consideration. 

TIP: Identifies advice or hints for the user, often in terms 
of performing a task. 

REFERENCE -EXTERNAL: Identifies an additional source 
of information outside of the bookset. 

REFERENCE - INTERNAL: Identifies an additional source 
of information within the bookset. 

CAUTION Indicates a situation which, if not avoided, may result in equipment 

or work (data) on the system being damaged or lost, or may result 

in 
the inability to properly operate the process. 

CAUTION: Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury. It may also be 
used to alert against unsafe practices. 

CAUTION symbol on the equipment refers the user to the 
product manual for additional information. The symbol appears 
next to required information in the manual. 

WARNING: Indicates a potentially hazardous situation, which, if 
not avoided, could result in serious injury or death. 

WARNING symbol on the equipment refers the user to the 
product manual for additional information. The symbol appears 
next to required information in the manual. 

WARNING, Risk of electrical shock: Potential shock hazard 
where HAZARDOUS LIVE voltages greater than 30 Vrms, 42.4 
Vpeak, or 60 VDC may be accessible. 
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Symbol Definition 

ESD HAZARD: Danger of an electro-static discharge to which 
equipment may be sensitive. Observe precautions for handling 
electrostatically sensitive devices. 

Protective Earth (PE) terminal: Provided for connection of the 
protective earth (green or green/yellow) supply system conductor. 

Functional earth terminal: Used for non-safety purposes such 
as noise immunity improvement. 

NOTE: This connection shall be bonded to Protective Earth at the 
source of supply in accordance with national local electrical code 
requirements. 

Earth Ground: Functional earth connection. 

NOTE: This connection shall be bonded to Protective Earth at 
the source of supply in accordance with national and local elec-
trical code requirements. 

Chassis Ground: Identifies a connection to the chassis or frame 
of the equipment shall be bonded to Protective Earth at the source 
of supply in accordance with national and local electrical code 
requirements. 
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1.1 Overview 

1. Introduction

This user’s guide describes the specifications, handling, and programming of the 2MLF- AD8A 

and 2MLF-AD16A analog/digital conversion module, which is used in combination with the 

CPU module of the MasterLogic-200 PLC series. 2MLF-AD8A and 2MLF-AD16A is hereafter 

referred to as the A/D conversion module. The A/D conversion module is used for converting 

the analog signals (voltage or current input) from a PLC external device into digital values of the 

signed 14 bit binary data. 

1.2 Features 

1. Hybrid input processing

a) 2MLF-AD8A: 8 channel current/voltage input can be processed in a single module.

b) 2MLF-AD16A: 16 channel current/voltage input can be processed in a single module.

2. High speed conversion

a) 2MLF-AD8A: High-speed conversion can be

processed through 250㎲/channel.

b) 2MLF-AD16A: High-speed conversion can be processed through 500㎲/channel.

3. High conversion accuracy

High conversion accuracy of ±0.2 % (ambient temperature of 25 ± 5C) is available.

4. High resolution of 1/16000

The high resolution of the digital values can be set at 1/16000.

5. Operating parameter setting and monitoring by using Graphical User Interface (GUI)

The operating setting which is conducted by commands can be manipulated by using I/O

parameter setting with improved user interface, which increases the user’s convenience.

You can reduce the sequence program by using I/O parameter setting.
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In addition, you can easily monitor the A/D converted values using special mod-

ule monitor function. 

6. Multiple digital output data formats

Four types of digital output data format are supported. The output type of the digital data

can be defined as follows:

− Unsigned value: 0 ~ 16000

− Signed value: -8000 ~ 8000

− Precise value: Performance specifications

− Percentile value: 0 ~ 10000

7. Input disconnection detection function

This function is used to detect the disconnection of input circuit when the analog input

signal range of 1 ~ 5V, 4 ~ 20mA is used.

1.3 Terminology 

Analog quantity – A 

Analog quantity refers to a physical value that is continuous. As analog values are continuous, 

there is always a median value. Physical properties such as voltage, current, velocity, pressure, 

and flow are included in the analog quantity. 

Figure 1 - Analog quantity 
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For example, the temperature changes continuously with time as shown in Figure 1. 

Since the temperature cannot be input directly into the A/D conversion module, it needs to 

be relayed by a transducer that converts input signals of analog properties into electrical 

signals. 

Figure 2 - An example of the transducer 

Digital quantity – D 

Figure 3 - Digital properties 

The data consisting of integers or the physical properties in numbers are referred to as digital 

properties (Figure 3). The digital properties are the electronic method of creating, storing, and 

processing the data in 0 and 1 format. The data transmitted or stored by digital technology is 

expressed as a string of 0 and 1. For example, the on and off signals can be expressed in 0 and 

1 digital values, and the BCD or binary values are also digital values. 
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Figure 4 - Process at PLC 

Analog quantity cannot be directly input to PLC CPU for calculation. Thus, convert analog 

quantity to digital quantity as in Figure 4, so the input on PLC CPU, is executed by analog input 

module. 

In addition, in order to output the analog quantity outward, convert PLC CPU’s digital quantity 

to analog quantity, which is executed by D/A conversion module. 

Characteristics of analog-digital conversion 

Voltage input 

Figure 5 - A/D conversion characteristics (voltage input) 
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The A/D conversion module is used to convert analog electric signal input from the external 

device to digital quantity. Analog input signal converted to digital quantity can be calculated in 

PLC CPU. If analog input range of -10 ~10V is used in voltage type of analog input module, 

analog input quantity of -10V’s digital value is 0, and 10 V’s digital value is 16000. Therefore, an 

analog input of 1.25mV is equivalent to digital value of 1 (Figure 5). 

Current input 

Figure 6 - A/D conversion characteristics (current 
input) 

If analog input range of 0~20mA is used as current type in A/D conversion 

module, 0mA of analog input quantity will output digital value of 0, and 

20mA will output digital value of 16000. In this case, analog input of 

1.25µA is equivalent to digital value of 1 
(Figure 6). 
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1.4 New functions 

The new functions of A/D conversion module are as follows: 

Item Description Module OS version CPU OS 
Version 

Ref. 

Hold last value 

When input signal 
exceeds effective 
range, holds last 
effective input value. 

V1.02 
Not related 

2.5 

Alarm function 

When input signal 
exceeds effective 
range, relevant alarm 
flag turns on. V1.02 

2MLK V3.2 

2MLI V3.1 

2MLR V1.7 2.5 
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2. Specifications

2.1 General specifications 

Table 1 specifies the general specifications of MasterLogic-200 series. 

Table 1 - General specifications 

No. Item Specification Related 
Standards 

1 Operating 
temperature 

055C - 

2 Storage 
temperature 

-25+70C - 

3 Operating 
humidity 

595%RH, no condensation - 

4 Storage 
humidity 

595%RH, no condensation - 

5 Vibration For intermittent vibration - - 

Frequency Acceleration Amplitude Number of 
times 

IEC 61131-2 

10 f  57Hz - 0.075mm 10 times each 
in directions 
X, Y, Z 57 f  

150Hz 

9.8m/s2(1G) - 

For incessant vibration 

Frequency Acceleration Amplitude 

10 f  57Hz - 0.075mm 

57 f  

150Hz 

4.9m/s2(1G) - 

6 Shock • Maximum impact acceleration: 147m/s2(15G)

• Supply time: 11ms

• Pulse wave pattern: Sign half-wave pulse (3 times each in
directions X, Y, and Z)

IEC 61131-2 
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No. Item Specification Related 
Standards 

7 Noise Square wave impulse noise 1500V In-house 
testing 
standard of 
Honeywell 
Industrial 
System 

Electrostatic discharge Voltage: 4kV 
(contact discharge) 

IEC 61131-2 

IEC 61000-4-2 

Radiating electromagnetic field noise 27~500MHz, 
10V/m 

IEC 61131-2, 

IEC 61000-4-3 

Fast 
transient/burst 
noise 

Class Power 
module 

Digital/analog 
input/output 
communication 
interface 

IEC 61131-2 

IEC 61000-4-4 

Voltage 2kV 1kV 

8 Environment No corrosive gas or dust - 

9 Altitude Below 2000m - 

10 Contamination Below 2 - 

ATTENTION 

1. IEC (International Electrotechnical Commission): An international private group
that aims at promoting international cooperation for standardization in electrical
and electronic technology areas, publishes international standards and oper-
ates related conformity assessment systems.

2. Contamination level: An index indicating contamination level of the
environment that determines the insulation of a device. For example, con-
tamination level 2 indicates there is only non-conductive contamination,
and there is temporary conductivity due to condensation.
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2.2 Performance specifications 

Table 2 specifies the performance specifications of an analog input module. 

Table 2 - Performance specifications 

Item 
Specifications 

Voltage Current 

Analog input 

DC 1~5V 

DC 0~5V 

DC 0~10V 

DC -10~10V 

(Input Resistance: 1MΩ minimum) 

DC 4~20mA 

DC 0~20mA 

(Input Resistance 250Ω) 

Analog input range 
setting 

• Selected current/voltage is set through a DIP switch. 

• Selected analog input range is set through SoftMaster user’s (or sequence) program 

or 
I/O parameter. 

• Respective input ranges can be set based on channels. 

Digital value 

(1) Voltage type 

(2) Current type 

Analog input 

Digital output 
1~5V 0~5V 0~10V -10~10V 

Unsigned value 0~16000 

Signed value -8000~8000 

Precise value 1000~5000 0~5000 0~10000 -10000~10000 

Percentile value 0~10000 

Analog input 

Digital value 
4~20mA 0~20mA 
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Item 
Specifications 

Voltage Current 

Signed value -8000~8000

Precise value 4000~20000 0~20000 

Percentile value 0~10000 

• 14-bit binary value (data: 14 bits).

• You can individually set the format of digital output data for each channel either from user
program or through user-friendly GUI I/O parameter function in SoftMaster.

Maximum 
resolution 

Analog input range Resolution (1/1600) Analog input range Resolution (1/1600) 

1~5V 250mV 
4~20mA 1.0µA 

0~5V 3125mV 

0~10V 625mV 
0~20mA 1.25µA 

-10~10V 250mV 

Accuracy 
±0.2% or less (when ambient temperature is 25±5oC) 

±0.3% or less (when ambient temperature is 0~55oC) 

Maximum 
conversion speed 

For 2MLF-AD8A: 250μs/channel 

For 2MLF-AD16A: 500μs/channel 

Absolute maximum 
input 

±15V ±30mA 

Analog input 
channels 

For 2MLF-AD8A: 8 channels/ module 

For 2MLF-AD16A: 16 channels/ module 

Isolation method 
Photo-coupler isolation between input terminal and PLC power (no isolation between channels) 

Terminal 
connected 

For 2MLF-AD8A: 18-point terminal 

For 2MLF-AD16A: 32-point terminal 

I/O addresses 
assigned 

Fixed type: 64 points, Variable type: 16 points 
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Item 
Specifications 

Voltage Current 

Internal-consumed 
current 

For 2MLF-AD8A: DC 5V, 420mA 

For 2MLF-AD16A: DC 5V, 330mA 

Weight 
For 2MLF-AD8A: 140g 

For 2MLF-AD16A: 115g 

ATTENTION 

• When A/D conversion module is released from the factory, Offset/Gain value is adjusted 
for respective analog input ranges. These values cannot be changed by the user. 

• Offset Value: Analog input value when digital output value is 0 with digital output format 
set to unsigned value. 

• Gain Value: Analog input value when digital output value is 16000 with digital output 
format set to unsigned value. 

• When analog input module is released from the factory, voltage/current selection switch is 
selected as current. 

• In 2MLF system, you can install it at extension base. But, you cannot install it at basic base. 
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2.3 Respective designations and functions 

Respective designations of the parts are as described below. 

Analog input module: 2MLF-AD8A 

No. Name Description 

Operation 
display 

Displays the operation status of 2MLF-AD8A 

• On: Operating normally

• Flickering: Error occurs (for more details, refer to
Error codes).

• Off: DC 5V disconnected, 2MLF-AD8A module
failure.

LED Terminal 
block 

The terminal block connected to an external device, for 
each channel, analog current/voltage to be input. 

Current/voltage The switch for setting the input time (current/voltage) 
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2.3. Respective designations and functions 

No. Name Description 

setting switch 

Switch Setting 

Off Voltage 

On Current 

Analog input module: 2MLF-AD16A 
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No. Description 

RUN LED 

Displays the operation status of analog input module (voltage, current) 

• On: Operation normal

• Flickering: Error occurs (for more details, refer to Error codes).

• Off: DC 5V disconnected, analog input module error.

Terminal 

• Analog input terminal, whose respective channels can be connected
with external devices.

Voltage/current selection switch 

• Switch to select voltage/current (left: voltage, right: current).
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2.4 Characteristics of I/O conversion 

Characteristics of I/O conversion are the inclination connected in a straight line between 

Offset and Gain values when converting analog signal (voltage or current input) from PLC’s 

external device to digital value. I/O conversion characteristics of analog input modules are as 

described below. 
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Input/output characteristics of 2MLF-AD8A and 2MLF-AD16A 

Being a 16 channel analog input module, you cannot set the offset/gain of the analog input module. 

The voltage input range can be set for each channel by using the user program or I/O parameter of 

SoftMaster. The output form of the digital data is defined as follows: 

• Unsigned value

• Signed value

• Precise value

• Percentile value

Input/output characteristics of 2MLF-AD16A is as described below: Note that the input/output 

characteristics for 2MLF-AD8A are also same. 

1. In the range of DC 4 ~ 20mA

a) Set the setting range at 4 ~ 20mA in I/O parameter of SoftMaster.
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b) The digital output values for the current input characteristics are as follows

(Resolution for 1/16000: 1μA).

Digital Output Range Analog Input Current (mA) 

3.808 4 8 12 16 20 20.191 

Unsigned value 

(-192~16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

(-8192~8191) 
-8192 -8000 -4000 0 4000 8000 8191 
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Precise value 

(3808~20191) 
3808 4000 8000 12000 16000 20000 20191 

Percentile value 

(-120~10119) 
-120 0 2500 5000 7500 10000 10119 

8. In the range of DC 0 ~ 20mA

a) Set the setting range at 0 ~ 20mA in I/O parameter of SoftMaster.

b) The digital output values for the current input characteristics are as follows (resolution

(for 1/16000): 1.25 μA).
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Digital Output Range 
Analog Input Current (mA) 

-0.24 0 5 10 15 20 20.23 

Unsigned value 

(-192~16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

(-8192~8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

(240~20239) 
-240 0 5000 10000 15000 20000 20239 

Percentile value 

(-120~10119) 
-120 0 2500 5000 7500 10000 10119 

9. In the range of DC 1 ~ 5V

a) Set the setting range at 1-5V in I/O parameter of SoftMaster.
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b) The digital output values for the voltage input characteristics are as follows (resolution (for

1/16000): 0.25mV).

Digital Output Range Analog Input Voltage (V) 

0.952 1 2 3 4 5 5.047 

Unsigned value 

(-192~16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

(-8192~8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

(952~5048) 
952 1000 2000 3000 4000 5000 5047 

Percentile value 

(-120~10119) 
-120 0 2500 5000 7500 10000 10119 

10. In the range of DC 0 ~ 5V

a) Set the setting range at 0 ~ 5V in I/O parameter of SoftMaster.
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b) The digital output values for the voltage input characteristics are as follows

(resolution (for 1/16000): 0.3125 mV).

Digital Output Range Analog Input Voltage (V) 

-0.06 0 1.25 2.5 3.75 5 5.05 

Unsigned value 

(-192~16191) 
-192 0 4000 8000 12000 16000 16191 
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Signed value 

(-8192~8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

(-60 ~ 5060)) 
-60 0 1250 2500 3750 5000 5059 

Percentile value 

(-120~10119) 
-120 0 2500 5000 7500 10000 10119 

11. In the range of DC 0 ~ 10 V

a) Set the setting range at 0 ~ 10V in I/O parameter of SoftMaster.
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b) The digital output values for the voltage input characteristics are as

follows (resolution (for 1/16000): 0.625 mV).

Digital Output Range Analog Input Voltage (V) 

-0.12 0 2.5 5 7.5 10 10.11 

Unsigned value 

(-192~16191) 
-192 0 4000 8000 12000 16000 16191 

Signed value 

(-8192~8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

(60~5059) 
-120 0 2500 5000 7500 10000 10119 

Percentile value 

(-120~10119) 
-120 0 2500 5000 7500 10000 10119 

12. In the range of DC-10 ~ 10V

a) Set the setting range at -10 ~ 10V in I/O parameter of SoftMaster.
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b) The digital output values for the voltage input characteristics are as follows (resolution (for

1/16000): 1.25 mV).

Digital Output Range Analog Input Voltage (V) 

-10.24 -10 -5 0 5 10 10.23 

Unsigned value 

(-192~16191) 
-192 0 4000 8000 12000 16000 16191 
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Signed value 

(-8192~8191) 
-8192 -8000 -4000 0 4000 8000 8191 

Precise value 

(10240~10238) 
-10240 0 2500 5000 7500 10000 10239 

Percentile value 

(-120~10119) 
-120 0 2500 5000 7500 10000 10119 

ATTENTION 

When a value out of the digital output range is input as the analog input value, the 
digital output value is maintained as the maximum or the minimum value that fall 
within the set output range. For example, when the digital output range is set as 
the unsigned value (–192 ~ 16191), and an analog value that exceed 6191 or -192 
is entered as the digital output value, the digital output value is fixed at 16191 or -
192. 

You cannot set the offset/gain of the analog input module. 

Precision 

CAUTION 

Do not set the voltage and current beyond ±15V and ±30mA, respectively. Otherwise, 
it may cause a failure due to over current/voltage. 

The precision for the digital output value does not change if the input range is changed. 

Figure 7 shows the range of precision at surrounding temperatures of 25 ± 5C when the analog 

input range and digital output type are set at -10 ~ 10V and Unsigned value, respectively. The 

precision is ±0.2% and ±0.3% when the temperature is 25 ± 5C and 0 ~ 65C, respectively. 
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Figure 7 - Precision (at 25 ± 5C) 

2.5 Functions of the analog input module 

Table 3 explains the functions of the analog conversion mod-

ule. 

Table 3 - List of functions 

Functions Description 

Channel run/stop Specify Run/Stop of the channel to 
execute A/D conversion. 

If the unused channel is set to Stop, 
whole Run time can be reduced. 

Input voltage/current ranges Set the analog input range you want to 
use. 

There are 4 input ranges for voltage 
input, and 2 for current input. 

Output data type Set the digital output type. 

4 output data types are provided in this 
module. 
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Functions Description 

A/D conversion type • Sampling processing

Sampling process will be performed if 
A/D conversion type is not specified. 

• Filter processing

Used to delay the sudden change of 
input value. 

• Average processing

Outputs average A/D conversion value 
based on frequency or time. 

Detection of an input disconnection If the analog input at 4 ~ 20mA and 1 ~ 5 
V is disconnected, it can be detected in 
the user program. 

Hold last value This function is supported at current input 
(4~20mA, 0~20mA). 

When input signal exceeds the effective 
range, holds the last effective value. 

Alarm function Separate setting is not necessary. 

When input signal exceeds the effective 
range, relevant flag turns on to let the 
user know. 

There are two A/D conversion methods: sampling processing and average processing. 

Sampling processing 

A common A/D conversion, sampling processing conducts A/D conversion by collecting analog 

input signals at regular intervals. The time it takes for the analog input signals to be A/D 

converted and stored in the memory differs according to the number of the channels being used. 

(Processing time) = (number of channels being used) X (conversion speed) 
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Example: The processing time when 3 channels are being used is 3 X 500µs = 1500μs 

Sampling means to calculate the sampling value of continuous analog signals at specific intervals. 

Average processing 

This process is used to execute A/D conversion of the channel designated for specified frequency or 

for specified time and save the average of the accumulated sum on memory. Average processing 

option and time/frequency value can be defined through user program or I/O parameters setting for 

respective channels. 

1. Use of average processing

This process is used for A/D conversion of abnormal analog input signal such as noise to a value near 

to normal analog input signal. 

2. Types of average processing:

Average processing divides into time, count, and weighted averages. Average processing type is of 

time average, count average, and weighted-average. 

a) Time average processing:

− Setting range: 16 ~ 16000ms

− Average processing count within specified time is decided based on the number of

channels used.

Example 1: The number of channels being used: 1, set time: 16000ms 

Example 2: The number of channels being used: 8, set time: 4ms 

*1: If you do not set the time average within 4 ~ 16000, RUN LED flashes every second. If you

want to keep RUN LED on, reset the time average within 4 ~ 16000 and switch the operating

mode of the CPU module from STOP to RUN. If you want
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to end the error through modification, you must use the clear request flag (UXY.11.0). 

*2: In case of an error of the time average value setting, the set value is saved as 4, which is

the initial value. The time average is converted into the number average inside the analog

input module. In this case, there can be a remainder, as time is divided by the number of

channels being used X conversion speed. The remainder is dropped, and the number of av-

erage processing processes is: (the number of channels being used X conversion speed)/(set

time).

Example: When the number of channels being used is 5 and the set time is 151ms. 151 ms ÷ 

(5 X 0.25 ms) = 120 times, the remainder is 8 → 120 times 

b) Count average processing:

− Settable range: 2 ~ 64000times

− When you use the number average, the time it takes for the average value to be saved in

the memory differs according to the number of the channels being used.

The processing time = the set number X the number of the channels being used X

conversion speed

*1: If you do not set the time average within 2 ~ 64000, RUN LED flashes every second. If

you want to keep RUN LED on, reset the time average within 2 ~ 64000 and switch the

operating mode of the CPU module from STOP to RUN. If you want to end the error

through modification, you must use the clear request flag (UXY.19.0).

*2: In case of an error of the number average value setting, the set value is saved as 2, which

is the initial value.

Example: when the number of channels being used is 4 and the number of aver-

age processing processes is 50 times. 

50 X 4 X 0.25ms = 50ms 

c) Weighted average processing:

Weighted average processing enables to get stable digital output values by filtering sudden 

changes of noise or input values. The weighted average constant can be set for each channel 

by setting the user program or I/O parameter. 

1. Settable range: 1 ~ 99(%)

• F[n] = (1 - α) x A[n] + α x F [n - 1], where
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− F[n]: the current weighted average output value

− A[n]: the current A/D conversion value

− F[n-1]: the previous weighted average output value

− α: weighted average constant (0.01 ~ 0.99: weighted value of the previous value)

a) If you do not set the time average within 1~99, RUN LED flashes every second. If you

want to keep RUN LED on, reset the time average within 4 ~ 16000 and switch the

operating mode of the CPU module from STOP to RUN. If you want to end the error

through modification, you must use the clear request flag (UXY.11.0).

b) In case of an error of the number average value setting, the set value is saved as 1, which is

the initial value.

2. Voltage input

a) The analog input range is set at DC -10 ~ 10V and the digital output range is set at 0 ~

16000.

b) When the analog input value changes –10V → 10V (0 → 16000), the weighted average

output value according to  is as follows.

 value 
Weighted Average Output Value 

Note 
- 1 scan 2 scans 3 scans 

*10.01 0 15840 15998 15999 
1% inclined toward previous 
value 

*20.5 0 8000 12000 14000 
50% inclined toward previous 
value 

*30.99 0 160 318 475 
99% inclined toward previous 
value 

*1: 16000 output after about 4 scans

*2: 16000 output after about 24 scans

*3: 16000 output after about 1491 scans (372.75ms in case of 1 channel operation)

3. Current input
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a) The analog input range is set at DC 0 ~ 20mA and the digital output range is set at 0 ~

16000.

b) When the analog input value changes 0mA → 1 mA (0 → 8000), the weighted average

output value according to  is as follows.

 value 
Weighted Average Output Value 

Note 
- 1 scan 2 scans 3 scans 

*10.01 0 7920 7999 7999 
1% inclined toward previous 
value 

*20.5 0 4000 6000 7000 
50% inclined toward previous 
value 

*30.99 0 80 159 237 
99% inclined toward previous 
value 

*1: 8000 output after about 4 scans

*2: 16000 output after about 21 scans

*3: 8000 output after about 1422 scans (355.5ms in case of 1 channel operation)

4. If you do not use the weighted average processing, the current A/D conversion value is the

direct output.

Weighted processing is getting data by entering a weighted value between the current and the

previous A/D conversion values, and the weighted value can be decided by the average value.

If there is much wavering of the output data, set the average value high.

Input disconnection detection function 

1. Input range available

You can detect disconnection of the input circuit when you use the input signal range of 4 ~ 20mA, 

1 ~ 5V. The conditions for detection of each input signal range is as shown in the table below. 

Input Signal Range Current/voltage Values Perceived as 
Disconnection 

1 ~ 5V Less than 0.2V 

4 ~ 20mA Less than 0.8mA 
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2. Display of disconnection by channel

The disconnection detection signal for each input channel is saved in UXY.18. (X represents the base 

number and Y the slot number.) 

BIT Description 

0 Normal 

1 Disconnected 

3. Operation

Each bit is set as 1 when a disconnection is detected of an allocated channel. Each bit can be used for 

detecting disconnection in the user program as shown in the table above. 

4. An example of the program

If a module is mounted in base 0, slot 2, below is an example of using the disconnection detection flag. 

If a disconnection is detected of the channel, the detected channel number is written in the P area. 

System configuration: 2MLF-AD8A: 
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2MLF-AD16A: 
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Hold last value (Dedicated for current input) 

When input signal exceeds the effective range, last input value is held. This function can be set for 

each channel by I/O parameter setting or user program. 

1. Input range to be used

This function can be used when you use input signal range of 4~20mA, 0~20mA. So this function can be 

used in current input module. In this function, for enable channel, only value of effective range is 

indicated. For example, in case output data type is unsigned value, the function is disabled, output data 

has the range -192~16191 But if the function is enabled, output data has the range 0~16000. 

Input 
Current 
Range 

Classification Unsigned Signed Precise Percentile 

4 ~ 20mA Disable -192~16191 -8192~8191 3808~20191 -120~10119

Enable 0~16000 -8000~8000 4000~20000 0~10000 

0 ~ 20mA Disable -192~16191 -8192~8191 -240~20239 -120~10119

Enable 0~16000 -8000~8000 0~20000 0~10000 

2. Operation

When this function is enabled and range is 4~20mA, output value corresponding to sample input 

value is as follows (Output data type: 0~16000). 

Input Current (mA) 12 3 4 4 21 20 

Output value 8000 8000 0 12000 12000 16000 

Ref. - Hold last 
value 

- - Hold last 
value 

- 

Alarm function 

When input signal exceeds effective range, relevant flag turns on. 

1. Input detection condition

Detection condition for each input signal range is as follows. 
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Input Signal 
Range 

Difference Tolerance Lower Limit Upper Limit 

4~20 mA 16 mA 1.2% 3.808 mA 20.192 mA 

0~20 mA 20 mA -0.24 mA 20.24 mA 

1~5 V 4 V 0.952 V 5.048 V 

0~5 V 5 V -0.06 V 5.06 V 

0~10 V 10 V -0.12 V 10.12 V 

-10~10 V 20 V -10.24 V 10.24 V 

2. Alarm indication for each channel

Alarm detection signal is saved at UXY.20 and UXY.21. If the input signal is within the effective 

range, alarm detection signal status is set to normal status automatically (X: base number, Y: slot 

number). 

UXY.20: upper limit 

BIT Description 

0 Normal 

1 Upper limit alarm 

UXY.21: lower limit 

BIT Description 

0 Normal 

1 Upper limit alarm 
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3. Installation and Wiring

3.1 Installation 

Installation environment 

This product is designed to perform well under various installation environments. However, 

for the sake of better reliability and stability of the complete system, follow these instructions. 

Environmental conditions 

• Install it on a waterproof and dustproof control panel.

• Avoid direct impact or vibrations.

• Do not expose to direct sunlight.

• Do not expose to rapid temperature change as it can cause dew formation.

• Maintain the ambient temperature between 0oC and 55oC.

Installation guidelines 

• Ensure that no wiring waste is left behind inside the PLC. All the wires to be properly

trimmed. Exercise caution and care while wiring or drilling screw holes.

• Install it in a location where it is easy for monitoring and use.

• Do not install on a panel that has high-voltage devices installed on it.

• Keep a distance of at least 50mm from a duct or other nearest module.

• Ensure proper grounding as per the guidelines to avoid electrical noise.
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3. Installation and Wiring 
3.1. Installation

Handling precautions 

CAUTION 

Precautions for handling the analog input module (from the unpacking to 
the installation) are as follows: 

1. Do not drop the unit.

2. Do not allow it to receive any type of strong impact.

3. Do not remove PCB from the case. It may lead to abnormal operation.

4. Do not let any external materials including wiring waste get inside the top of
the module when wiring. While closing the unit, remember to remove any
external materials that may have got inside.

5. Do not install or remove the module while power is ON.
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3.2 Wiring 

Wiring precautions 

CAUTION 

1. The AC power lines should not be allowed close to the external input
line of A/D conversion module as they can cause surges and inductive
noise leading to abnormal operation.

2. Select the cable based on the ambient temperature and allowable cur-
rent. Its size should not be less than the maximum cable standard of
AWG22 (0.3mm2).

3. The cable should not run close to hot devices and should not come in
direct contact with oil for long. This can cause short-circuit and result
in abnormal operation.

4. Check the polarity when wiring the terminal.

5. Wiring with high-voltage line or power line may produce inductive hindrance
causing abnormal operation or defect.

Wiring examples 

Voltage input 

2MLF-AD8A: 

2MLF-AD16A: 
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3.2. Wiring 

Current input 

2MLF-AD8A: 

2MLF-AD16A: 

• *1: Use a 2-core twisted shielded wire. AWG 22 is recommended for the cable standard. 

• *2: Analog input module’s input resistance is 250Ω (typical). 

• *3: Analog input module’s input resistance is 1MΩ (minimum). 

Wiring example of 2-wire sensor/transmitter (current input) 
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3. Installation and Wiring 
3.2. Wiring 

2MLF-AD8A: 

2MLF-AD16A: 

• Enable (Run) only the channels those are used and disable the rest to 

maintain best overall conversion speed. 

• Analog input module does not provide power for the input device. 

Use an external power supply. 

Wiring example of 4-wire sensor/transmitter (voltage/current input) 

2MLF-AD8A: 
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3. Installation and Wiring 
3.2. Wiring

2MLF-AD16A: 

• Start the channel to be used.

• Analog input module does not provide power for the input device. Use an external power

supplier.

• *1: Use a 2-core twisted shielded wire. AWG 22 is recommended for the cable standard.

• *2: Analog input module’s input resistance is 250Ω (typical).

• *3: Analog input module’s input resistance is 1MΩ (minimum).

Relationship between voltage input accuracy and wiring length 

In voltage input, the wiring (cable) length between transmitter or sensor and module has an effect on 

digitally-converted values of the module as specified below. 

where, 

Rc: Resistance value due to line resistance of cable Rs: Internal resistance value of transmitter or sensor 

Ri: Internal resistance value (1MΩ) of voltage input module 
Vin: Voltage allowed to analog input module 

% Vi: Tolerance of converted value (%) due to source and cable length in voltage input 
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3. Installation and Wiring 
3.2. Wiring 

 

ATTENTION 

In current input, there is no accuracy; tolerance is caused by cable length and 
internal resistance of the source. 
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4. Operation Procedures and Monitoring 

4.1 Operation procedures 

Figure 8 describes the procedure for the operation. 

Figure 8 - Procedures for the operation 
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4. Operation Procedures and Monitoring 
4.2. Operating parameter settings

4.2 Operating parameter settings 

You can specify the analog input conversion module’s operation parameters through 

SoftMaster’s I/O parameters. 

Settings 

For the user’s convenience of analog input module, SoftMaster provides a graphical user interface 

(GUI) for parameter settings of analog input module. Settings available in I/O parameters on the 

SoftMaster project window are as described in Table 4. 

Table 4 - Function of I/O parameters 

Item Details 

I/O parameters The following settings are necessary for the module’s operation. 

• Channel Enable/Disable Setting

• Input Voltage/Current Range Settings

• Digital Output Data Format Setting

• Average Processing Method Setting

• Average Value Setting

The data specified by user through SoftMaster is directly saved on analog 
input module when Special Module Parameters are downloaded. In other 
words, the download has no relevance to the CPU status, that is, RUN or 
STOP. 
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I/O parameters 

Use of I/O parameters for 2MLF-AD16A is as described below. 

Note that the steps to use I/O parameters for 2MLF-AD8A are also same. 

Step 

Action 
1 Double-click SoftMaster to view the Project window. Refer to SoftMaster User’s Guide 

for details regarding creating a project. 

2 On the Project window, double-click I/O Parameters. The I/O Parameters Setting 
window displays. 
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4. Operation Procedures and Monitoring 
4.2. Operating parameter settings

Step Action 

3 Click the slot where the analog input module is installed. Here, the 16- channel 
voltage type of analog input module is installed on Base No. 0, Slot No. 4. 

4 Click the arrow button to display the list of applicable modules. Select the 
appropriate module from the list. 

5 After you select the module, click Details. 
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6 The window displays the list of parameters for the respective channels as shown below. 
Select the parameters one by one and specify their values as explained below. 

a) Channel Status: Enables the channels that are used and disables the rest.

b) Input range: Select the range for analog input voltage (or current) as desired.
The analog input module provides four voltage input ranges, and two current input
ranges.

c) Output type: Select one of the four output data formats available.



4. Operation Procedures and Monitoring 
4.2. Operating parameter settings 

Step Action 

R210
June 2022 

Analog Input Module 2MLF-AD8A, AD16A User's Guide 
Honeywell 

67 



4. Operation Procedures and Monitoring 
4.2. Operating parameter settings

Step Action 

68 Analog Input Module 2MLF-AD8A, AD16A User's Guide 
Honeywell 

R210
June 2022 

d) Average processing: This field is active only when the average process is enabled.
Set the average processing type, four methods are available.

e) Average value: This field is active only when the average process setting is
enabled. Double-click the average value to input the value. The available range is 2
~ 64000 for count average, and 16 ~ 16000 for time average and 0~99 range for
weighted average. If the value exceeds the specified range, input is not available.

f) Hold Last vaue: If you enable this function, when input value exceeds the effective
range, it holds the last value. When input signal exceeds the effective range, last
input value is held.

g) To select a particular parameter value for all channels at the same time, select the
checkbox next to the respective parameter item and then change the parameter.
Figure shows an example where the Channel Status of all the channels are
enabled at the same time.



4. Operation Procedures and Monitoring 
4.2. Operating parameter settings 

Step Action 

R210
June 2022 

Analog Input Module 2MLF-AD8A, AD16A User's Guide 
Honeywell 

69 

Without any programming, the above test function, special module monitoring can 
be used for checking the operation and functions of A/D conversion module. 
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4.3 Special module monitoring functions 

The special module monitoring function is a diagnostic tool helps you to 

monitor the analog input modules for testing purposes. It also helps tuning 

some parameters, that is, average processing constants. Without any pro-

gramming, the above test function can be used to check the operation and 

functions of analog input modules. 

Item Description Note 

Special module monitor 
Monitor 

Through the 
SoftMaster, click Mon-
itor > Special Module 
Monitoring to monitor 
the analog input con-

version value or test the 

operation of the analog 
input module. 

Minimum/maxim-
um monitor 

The max./min. value of 
the channel can be 
monitored during Run. 
However, the max./min. 
value displayed are based 
on the current value on 
the window. Accordingly, 
when Monitoring window 
is closed, the max./min. 
value will not be saved. ATTENTION 

The window may not be normally displayed due to insufficient system resource. In such 
a case, close the window and close other applications, in order to restart SoftMaster. 
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4.4. Percautions 

4.4 Percautions 

The parameters specified for the test of analog input module on the Special Module Monitor 

window of Special Module List is deleted the moment the Special Module Monitor window is 

closed. In other words, the parameters of analog input module specified on the Special Module 

Monitor window is not saved in I/O parameters located on the left tab of SoftMaster. 

Not saved in I/O parameters 

Test function of Special Module Monitor is provided for user to check the normal operation 

of analog input module even without sequence programming. If analog input 
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module is to be used for other purposes than a test, use parameter setting function in I/O parameters. 
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4.5 Special module monitoring 

Monitoring of 2MLF-AD16A is as described below. 

Note that the steps to monitor 2MLF-AD8A are also same. 

Starting of special module monitoring 

Step Action 

1 In SoftMaster, click Online > Connect to connect to the PLC. 

2 Click Monitor > Special Module Monitoring to start monitoring. 

ATTENTION 

If the status is not Online, Special Module 
Monitoring menu is not active. 

Using special module monitoring 

Step Action 

1 Connect SoftMaster linked to the PLC CPU (online status). 

Click Monitor > Special Module Monitoring. The Special Module Select 
window displays. In addition to special module type, it shows the base/slot 
information. The module installed on the Current PLC displays the Special 
Module List window. 
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2 Select Special Module and click Module Information to view the module   information. 

3 Select the module from Special Module List window and click Monitor. The 

following window displays. 
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The four buttons available are: 

• Reset max./min value

• Start Monitoring

• Test

• Close

The current value of A/D conversion output and maximum/minimum value displays in 
upper-half of the monitoring window. Parameter settings for each selected channel 
displays in the lower-half of the monitoring window. 

4 Start Monitoring: Click Start Monitoring button to display the current values A/D 
conversion output of all channels. 

The monitoring screen as shown below displays when the all channels of analog input 
module are in Stop status. The currently specified parameters of   
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analog input module displays in the lower-half of the window. 

5 Test: This button is used for temporarily changing the current parameters of 
analog input module for testing purpose. Make suitable parameter changes 
in the lower-half of the window and click Test button to execute the change. 

The figure below displays after Test is executed with channel 0’s input
voltage range changed to 1 ~ 5 V in the state of input not wired. 
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6 Reset Max./Min. value: The maximum/minimum value field in the window 
shows the maximum and minimum value of A/D conversion computed for the 
current session. Click Reset max./min. value to initialize them. 
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7 Close: This button is used for closing the monitoring/test window. 

Note that the maximum value, the minimum value and the current values 
are not saved once the window is closed. 
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4.6 Register special/communication module variables 

This section describes the automatic registration function of Special Module Variables in the 

SoftMaster. 

Registering of 2MLF-AD16A is as described below. 

Note that the registering steps for 2MLF-AD8A are also same. 

Registering special/communication module variables 

Register the variables for each module referring to the special module information set in the 

I/O parameters. You can modify the variables and address. 

Perform the following steps to modify the variables and address. 

Step Action 

1 On the I/O Parameter Setting window, select the special module type. 

2 On the Project window, double-click Global Variable/Address 

3 Click Edit > Register Special/Communication Module Variables. 

4 A confirmation message displays as shown below. Click Yes. Note that all existing 
address for these registers are deleted. 

5 The variables are automatically registered as shown below. 
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Step Action 

Saving variables 

The contents of ‘View Variable’ can be saved as a text file. 

1. Click Edit > Export Variables to File and provide the folder/file

name of your choice.

2. The contents of ‘View Variable’ is saved as a text file.

Viewing variables in the program 

An example program of SoftMaster is as shown below. 
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Figure 9 - Program example 
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Select View > Variables, variables displays. The devices are changed into variables. 

Figure 10 - Example for variables 
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Select View > Devices/Variables, both devices and variables displays. 

Figure 11 - Example for devices and variables 
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5. Configuration and Functions of the Internal Memory 

5.1 Internal memory configuration 

Analog input module has an internal memory to transmit/receive data to/from 

PLC CPU. This section describes the configuration of the internal memory. 

Input and output areas of A/D converted data 

2MLF-AD8A 

Table 5 describes the input and output ranges of the analog input data. 

Table 5 - Input and output ranges of the analog input 
data 

Global Variable Memory 
Allocation 

Contents Read/ 
Write 

Signal 
Directio n 

_ab_ERR 

_ab_RDY 

%UXa.b.0 

%UXa.b.15 

Module ERROR flag 

Module READY flag 

Read A/D →CPU 

_ab_CH0_ACT 

_ab_CH1_ACT 

_ab_CH2_ACT 

_ab_CH3_ACT 

_ab_CH4_ACT 

_ab_CH5_ACT 

_ab_CH6_ACT 

_ab_CH7_ACT 

%UXa.b.16 

%UXa.b.17 

%UXa.b.18 

%UXa.b.19 

%UXa.b.20 

%UXa.b.21 

%UXa.b.22 

%UXa.b.23 

CH 0 RUN flag   

CH 1 RUN flag   

CH 2 RUN flag   

CH 3 RUN flag   

CH 4 RUN flag   

CH 5 RUN flag   

CH 6 RUN flag 

CH 7 RUN flag 

Read A/D →CPU 

_ab_CH0_DATA 

_ab_CH1_DATA 

_ab_CH2_DATA 

_ab_CH3_DATA 

%UWa.b.2 

%UWa.b.3 

%UWa.b.4 

%UWa.b.5 

CH 0 Digital output value (conversion value)   

CH 1 Digital output value (conversion value)   

CH 2 Digital output value (conversion value) 

CH 3 Digital output value (conversion value) 

Read A/D →
CPU 
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5.1. Internal memory configuration

Global Variable Memory 
Allocation 

Contents Read/ 
Write 

Signal 
Directio 

n 

_ab_CH4_DATA 

_ab_CH5_DATA 

_ab_CH6_DATA 

_ab_CH7_DATA 

%UWa.b.6 

%UWa.b.7 

%UWa.b.8 

%UWa.b.9 

CH 4 Digital output value (conversion value) 

CH 5 Digital output value (conversion value) 

CH 6 Digital output value (conversion value) 

CH 7 Digital output value (conversion value) 

_ab_CH0_IDD 

_ab_CH1_IDD 

_ab_CH2_IDD 

_ab_CH3_IDD 

_ab_CH4_IDD 

_ab_CH5_IDD 

_ab_CH6_IDD 

_ab_CH7_IDD 

%UXa.b.160 

%UXa.b.161 

%UXa.b.162 

%UXa.b.163 

%UXa.b.164 

%UXa.b.165 

%UXa.b.166 

%UXa.b.167 

CH 0 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

CH 1 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

CH 2 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

CH 3 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

CH 4 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

CH 5 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

CH 6 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

CH 7 disconnection detection flag (1 ~ 5 V OR 4 ~ 20 mA) 

Read 

_ab_ERR_CLR %UXa.b.176 Error clear request flag Write CPU →
A/D 

_ab_CH0_HOOR 

_ab_CH1_HOOR 

_ab_CH2_HOOR 

_ab_CH3_HOOR 

_ab_CH4_HOOR 

_ab_CH5_HOOR 

_ab_CH6_HOOR 

_ab_CH7_HOOR 

%UXa.b.320 

%UXa.b.321 

%UXa.b.322 

%UXa.b.323 

%UXa.b.324 

%UXa.b.325 

%UXa.b.326 

%UXa.b.327 

CH0 alarm upper limit 

CH1 alarm upper limit 

CH2 alarm upper limit 

CH3 alarm upper limit 

CH4 alarm upper limit 

CH5 alarm upper limit 

CH6 alarm upper limit 

CH7 alarm upper limit 

Read A/D →
CPU 

_ab_CH0_LOOR 

_ab_CH1_LOOR 

_ab_CH2_LOOR 

%UXa.b.336 

%UXa.b.337 

%UXa.b.338 

CH0 alarm lower limit 

CH1 alarm lower limit 

CH2 alarm lower limit 

Read A/D →
CPU 
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Global Variable Memory 
Allocation 

Contents Read/ 
Write 

Signal 
Directio 

n 

_ab_CH3_LOOR 

_ab_CH4_LOOR 

_ab_CH5_LOOR 

_ab_CH6_LOOR 

_ab_CH7_LOOR 

%UXa.b.339 

%UXa.b.340 

%UXa.b.341 

%UXa.b.342 

%UXa.b.343 

CH3 alarm lower limit 

CH4 alarm lower limit 

CH5 alarm lower limit 

CH6 alarm lower limit 

CH7 alarm lower limit 

At the device allocation, a means base number and b means slot number where the 

module is installed. 

2MLF-AD16A 

Table 6 describes the I/O area of A/D converted data. 

Table 6 - Input and output ranges of the analog input data 

Global Variable Memory 
Allocation 

Contents Read/Write 

_ab_ERR 

_ab_RDY 

%UXa.b.0 

%UXa.b.15 

Module ERROR flag 

Module READY flag 

Read 

_ab_CH0_ACT 

_ab_CH1_ACT 

_ab_CH2_ACT 

_ab_CH3_ACT 

_ab_CH4_ACT 

_ab_CH5_ACT 

_ab_CH6_ACT 

_ab_CH7_ACT 

_ab_CH8_ACT 

%UXa.b.16 

%UXa.b.17 

%UXa.b.18 

%UXa.b.19 

%UXa.b.20 

%UXa.b.21 

%UXa.b.22 

%UXa.b.23 

%UXa.b.24 

CH 0 RUN flag 

CH 1 RUN flag 

CH 2 RUN flag 

CH 3 RUN flag 

CH 4 RUN flag 

CH 5 RUN flag 

CH 6 RUN flag 

CH 7 RUN flag 

CH 8 RUN flag 

Read 
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Global Variable Memory 
Allocation 

Contents Read/Write 

_ab_CH9_ACT 

_ab_CH10_ACT 

_ab_CH11_ACT 

_ab_CH12_ACT 

_ab_CH13_ACT 

_ab_CH14_ACT 

_ab_CH15_ACT 

%UXa.b.25 

%UXa.b.26 

%UXa.b.27 

%UXa.b.28 

%UXa.b.29 

%UXa.b.30 

%UXa.b.31 

CH 9 RUN flag 

CH 10 RUN flag 

CH 11 RUN flag 

CH 12 RUN flag 

CH 13 RUN flag 

CH 14 RUN flag 

CH 15 RUN flag 

_ab_CH0_DATA 

_ab_CH1_DATA 

_ab_CH2_DATA 

_ab_CH3_DATA 

_ab_CH4_DATA 

_ab_CH5_DATA 

_ab_CH6_DATA 

_ab_CH7_DATA 

_ab_CH8_DATA 

_ab_CH9_DATA 

_ab_CH10_DATA 

_ab_CH11_DATA 

_ab_CH12_DATA 

_ab_CH13_DATA 

_ab_CH14_DATA 

_ab_CH15_DATA 

%UWa.b.2 

%UWa.b.3 

%UWa.b.4 

%UWa.b.5 

%UWa.b.6 

%UWa.b.7 

%UWa.b.8 

%UWa.b.9 

%UWa.b.10 

%UWa.b.11 

%UWa.b.12 

%UWa.b.13 

%UWa.b.14 

%UWa.b.15 

%UWa.b.16 

%UWa.b.17 

CH 0 Digital output value (conversion value) 

CH 1 Digital output value (conversion value) 

CH 2 Digital output value (conversion value) 

CH 3 Digital output value (conversion value) 

CH 4 Digital output value (conversion value) 

CH 5 Digital output value (conversion value) 

CH 6 Digital output value (conversion value) 

CH 7 Digital output value (conversion value) 

CH 8 Digital output value (conversion value) 

CH 9 Digital output value (conversion value) 

CH 10 Digital output value (conversion value) 

CH 11 Digital output value (conversion value) 

CH 12 Digital output value (conversion value) 

CH 13 Digital output value (conversion value) 

CH 14 Digital output value (conversion value) 

CH 15 Digital output value (conversion value) 

Read 

_ab_CH0_IDD 

_ab_CH1_IDD 

%UXa.b.288 

%UXa.b.289 

CH 0 disconnection detection flag 

CH 1 disconnection detection flag 

Read 
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Global Variable Memory 
Allocation 

Contents Read/Write 

_ab_CH2_IDD 

_ab_CH3_IDD 

_ab_CH4_IDD 

_ab_CH5_IDD 

_ab_CH6_IDD 

_ab_CH7_IDD 

_ab_CH8_IDD 

_ab_CH9_IDD 

_ab_CH10_IDD 

_ab_CH11_IDD 

_ab_CH12_IDD 

_ab_CH13_IDD 

_ab_CH14_IDD 

_ab_CH15_IDD 

%UXa.b.290 

%UXa.b.291 

%UXa.b.292 

%UXa.b.293 

%UXa.b.294 

%UXa.b.295 

%UXa.b.296 

%UXa.b.297 

%UXa.b.298 

%UXa.b.299 

%UXa.b.300 

%UXa.b.301 

%UXa.b.302 

%UXa.b.303 

CH 2 disconnection detection flag 

CH 3 disconnection detection flag 

CH 4 disconnection detection flag 

CH 5 disconnection detection flag 

CH 6 disconnection detection flag 

CH 7 disconnection detection flag 

CH 8 disconnection detection flag 

CH 9 disconnection detection flag 

CH 10 disconnection detection flag 

CH 11 disconnection detection flag 

CH 12 disconnection detection flag 

CH 13 disconnection detection flag 

CH 14 disconnection detection flag 

CH 15 disconnection detection flag 

_ab_ERR_CLR %UXa.b.304 Error clear request flag Write 

_ab_CH0_HOOR 

_ab_CH1_HOOR 

_ab_CH2_HOOR 

_ab_CH3_HOOR 

_ab_CH4_HOOR 

_ab_CH5_HOOR 

_ab_CH6_HOOR 

_ab_CH7_HOOR 

_ab_CH8_HOOR 

_ab_CH9_HOOR 

%UXa.b.320 

%UXa.b.321 

%UXa.b.322 

%UXa.b.323 

%UXa.b.324 

%UXa.b.325 

%UXa.b.326 

%UXa.b.327 

%UXa.b.328 

%UXa.b.329 

CH0 alarm upper limit 

CH1 alarm upper limit 

CH2 alarm upper limit 

CH3 alarm upper limit 

CH4 alarm upper limit 

CH5 alarm upper limit 

CH6 alarm upper limit 

CH7 alarm upper limit 

CH8 alarm upper limit 

CH9 alarm upper limit 

Read 
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Global Variable Memory 
Allocation 

Contents Read/Write 

_ab_CH10_HOOR 

_ab_CH11_HOOR 

_ab_CH12_HOOR 

_ab_CH13_HOOR 

_ab_CH14_HOOR 

_ab_CH15_HOOR 

%UXa.b.330 

%UXa.b.331 

%UXa.b.332 

%UXa.b.333 

%UXa.b.334 

%UXa.b.335 

CH10 alarm upper limit 

CH11 alarm upper limit 

CH12 alarm upper limit 

CH13 alarm upper limit 

CH14 alarm upper limit 

CH15 alarm upper limit 

_ab_CH0_LOOR 

_ab_CH1_LOOR 

_ab_CH2_LOOR 

_ab_CH3_LOOR 

_ab_CH4_LOOR 

_ab_CH5_LOOR 

_ab_CH6_LOOR 

_ab_CH7_LOOR 

_ab_CH8_LOOR 

_ab_CH9_LOOR 

_ab_CH10_LOOR 

_ab_CH11_LOOR 

_ab_CH12_LOOR 

_ab_CH13_LOOR 

_ab_CH14_LOOR 

_ab_CH15_LOOR 

%UXa.b.336 

%UXa.b.337 

%UXa.b.338 

%UXa.b.339 

%UXa.b.340 

%UXa.b.341 

%UXa.b.342 

%UXa.b.343 

%UXa.b.344 

%UXa.b.345 

%UXa.b.346 

%UXa.b.347 

%UXa.b.348 

%UXa.b.349 

%UXa.b.350 

%UXa.b.351 

CH0 alarm lower limit 

CH1 alarm lower limit 

CH2 alarm lower limit 

CH3 alarm lower limit 

CH4 alarm lower limit 

CH5 alarm lower limit 

CH6 alarm lower limit 

CH7 alarm lower limit 

CH8 alarm lower limit 

CH9 alarm lower limit 

CH10 alarm lower limit 

CH11 alarm lower limit 

CH12 alarm lower limit 

CH13 alarm lower limit 

CH14 alarm lower limit 

CH15 alarm lower limit 

Read 

_ab_ERR_CTR %UXa.b.352 Error clear request flag (V1.02) Write 

At the device allocation, a means base number and b means slot number where the 

module is installed. 
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Examples for 2MLK 

1. In the device assigned, X stands for the Base No. and Y for the Slot No. on which 

module is installed. 

2.  In order to read ‘CH1 digital output value’ of analog input module installed on Base No.0, 

Slot No.4, it will be displayed as U04.03. 

(a) Base number setting range: 0 ~ 7 

(b) Slot number setting range: 0 ~ 15 

3. In order to read ‘Flag to detect CH4 disconnection’ of analog input module installed on 

Base No.0, Slot No.5, it will be displayed as U05.10.4. 

Operation parameters setting range 

Operation parameter of analog input module can be set through I/O Parameter of   SoftMaster. 

SoftMaster provides the Graphical User Interface (GUI) type parameter setting of the analog 

input module, in order to enhance the user’s convenience of the analog input module. 
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Table 7 describes the operating parameter setting range of the analog input module. 

Table 7 - Operating parameter setting ranges 

Memory Address Description Read/Write 

Hexadecimal Decimal 

0H 

0 Specifies the channel in use 

Read/Write 

1H 

1 Input voltage/current ranges 1 2H 2 Input voltage/current ranges 2 

3H 3 Output data range Read/Write 

4H 4 Average processing 

5H 5 Channel 0 average 

6H 6 Channel 1 average 

7H 7 Channel 2 average 

8H 8 Channel 3 average 

9H 9 Channel 4 average 

AH 10 Channel 5 average 

BH 11 Channel 6 average 

CH 12 Channel 7 average 

DH 13 Error code Read 

EH 14 Hold value Read/Write 
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2MLF-AD16A 

Table 8 describes the setting range of analog input module’s operating parameters. 

Table 8 - Operating parameters setting range 

Memory Address Description Read/Write Remarks 

Hexadecimal Decimal 

0H 0 Channel enable/disable setting Read/Writ 
e 

1H 1 Setting ranges of input 
voltage/current 1 

2H 2 Setting ranges of input 
voltage/current 2 

3H 3 Setting ranges of input 
voltage/current 3 

4H 4 Setting ranges of input 
voltage/current 4 

5H 5 Output data format setting 1 

6H 6 Output data format setting 2 

7H 7 Average process designation 1 

8H 8 Average process designation 2 

9H 9 Ch0 average value designation 

AH 10 Ch1 average value designation 

BH 11 Ch2 average value designation 

CH 12 Ch3 average value designation 

DH 13 Ch4 average value designation 

EH 14 Ch5 average value designation 

FH 15 Ch6 average value designation 

10H 16 Ch7 average value designation 

11H 17 Ch8 average value designation 
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Memory Address Description Read/Write Remarks 

Hexadecimal Decimal 

12H 18 Ch9 average value designation 

13H 19 Ch10 average value designation 

14H 20 Ch11 average value designation 

15H 21 Ch12 average value designation 

16H 22 Ch13 average value designation 

17H 23 Ch14 average value designation 

18H 24 Ch15 average value designation 

19H 25 Error code 

1AH 26 Hold last value More 
than OS 
version 
1.02 

5.2 A/D conversion data input/output ranges 

Module READY/ERROR flag (UXY.00, X: Base No., Y: Slot No.) 

1. UXY.00.F: It will be ON when PLC CPU is powered or reset with 

A/D conversion ready to process A/D conversion. 

2. UXY.00.0: It is a flag to display the error status of analog input module. 
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Operating channel flag (UXY.01, X: base number, Y: slot number) 

The location where the operating information of respective channels are saved. 

2MLF-AD8A 

2MLF-AD16A 
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Digital output value (UXY.02 ~ UXY.17, X: Base No., Y: Slot No.) 

1. A/D converted-digital output value will be output to buffer memory addresses 2 

~ 17 (UXY.02 ~ UXY.17) for respective channels. 

2. Digital output values are saved in binary numbers of 16 bit. 

2MLF-AD8A 

Address Details 

Address No.2 CH0 digital output value 

Address No.3 CH1 digital output value 

Address No.4 CH2 digital output value 

Address No.5 CH3 digital output value 

Address No.6 CH4 digital output value 

Address No.7 CH5 digital output value 

Address No.8 CH6 digital output value 

Address No.9 CH7 digital output value 

2MLF-AD16A 

Address Details 

Address No.2 CH0 digital output value 

Address No.3 CH1 digital output value 
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Address No.4 CH2 digital output value 

Address No.5 CH3 digital output value 

Address No.6 CH4 digital output value 

Address No.7 CH5 digital output value 

Address No.8 CH6 digital output value 

Address No.9 CH7 digital output value 

Address No.10 CH8 digital output value 

Address No.11 CH9 digital output value 

Address No.12 CH10 digital output value 

Address No.13 CH11 digital output value 

Address No.14 CH12 digital output value 

Address No.15 CH13 digital output value 

Address No.16 CH14 digital output value 

Address No.17 CH15 digital output value 

Disconnection detection flag (UXY.18.Z, X: base number, Y: slot number, 
Z: channel number) 

1. The disconnection detection signals for each input channel is stored in UXY.18. 

2. Each bit is set as 1 when a disconnection is detected for the allocated channel, 

and turns into 0 when the disconnection is recovered. Each bit can be used for 

disconnection detection in the user program as operating conditions. 

2MLF-AD8A 

BIT Description 

0 Normal 

1 Disconnection 



5. Configuration and Functions of the Internal Memory 
5.2. A/D conversion data input/output ranges 

98 Analog Input Module 2MLF-AD8A, AD16A User's Guide 
Honeywell 

R210 
June 2022 

2MLF-AD16A 

BIT Description 

0 Normal 

1 Disconnection 

Error clear request flag (UXY.19.0, X: base number, Y: slot number) 

1. If a parameter setting error occurs, address No.22’s error code will not be automatically 

erased even if parameters are changed correctly. At this time, turn the ‘error clear request’ 

bit ON to delete address No.22’s error code and the error displays in SoftMaster’s 

System Monitoring. In addition, RUN LED which blinks will be back to On status. 

2. You have to use the error clear request flag along with UXY.00.0 for normal operation as 

shown in figure below. 

2MLF-AD8A 
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Figure 12 - Using the error clear request flag 

2MLF-AD16A 

Figure 13 - Using the flag 

Flag to request error clear (UXY.22.0, X: base number, Y: slot number) 

1. In higher than OS version 1.02, use address UXY.22.0 for error clear 

request flag. Except address, all functions are same with error clear 

request flag used in previous version. 

2. In lower than OS version 1.02, use address UXY.19.0 for error clear request flag. 
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5.3 Operation parameters setting range 

Each address of the internal memory is occupied by 1 word, which can be expressed in 

16 bit. Each function can be used by setting the 16 bit that comprises the address at, 1 

when On for each bit and at 0 when Off for each bit. 

Specifying the channel to use (address No.0) 

1. You can set whether to allow/block A/D conversion for each channel. 

2. You can reduce the conversion cycle for channels by blocking conversion of 

the channel you do not use. 

3. When no channel is designated for use, all the channels are set as not used. 

4. Allow/block of A/D conversion is as follows. 

2MLF-AD8A 

BIT Description 

0 Disable 

1 Enable 

2MLF-AD16A 

BIT Description 

0 Disable 

1 Enable 
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Specifying the range of input voltage/current (address No.1~4) 

1. You can set the range of the analog input voltage/current for each channel. 

2. When no analog input range is specified, all the channels are set as 4 ~ 20mA. 

3. The range of the analog input voltage/current is set as follows. 

2MLF-AD8A 

BIT Description 

0000 4 mA ~ 20 mA 

0001 0 mA ~ 20 mA 

0010 1 V ~ 5 V 

0011 0 V ~ 5 V 

0100 0 V ~ 10 V 

0101 -10 V ~ 10 V 
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2MLF-AD16A 

BIT Description 

0000 4 mA ~ 20 mA 

0001 0 mA ~ 20 mA 

0010 1 V ~ 5 V 

0011 0 V ~ 5 V 

0100 0 V ~ 10 V 

0101 -10 V ~ 10 V 
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Specifying the range of output data (address No.5~ address No.6) 

1. You can set the range of the digital output data for analog input for each channel. 

2. When no output data range is specified, all the channels are set as 0 ~ 16000. 

3. The range of the digital output data is as follows. 

2MLF-AD8A 

BIT Description 

00 0 ~ 16000 

01 -8000 ~ 8000 

10 Precise Value 

11 0 ~ 10000 

2MLF-AD16A 
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BIT Description 

00 0 ~ 16000 

01 -8000 ~ 8000 

10 Precise Value 

11 0 ~ 10000 

The precise values for 2MLF-AD8A and 2MLF-AD16A are same. 

The precise values have the following digital output range for the analog input range. 

a) Current 

Analog input 

Digital output 
4 ~ 20mA 0 ~ 20mA 

Precise Value 4000 ~ 20000 0 ~ 20000 

b) Voltage 

Analog input 

Digital output 
-10 ~ 10V 0 ~ 10V 0 ~ 5V 1 ~ 5V 

Precise Value -10000 ~ 10000 0 ~ 10000 0 ~ 5000 
1000 ~ 
5000 
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Specifying average process (address No.7~address No.8) 

1. You can specify the method of average processing for each channel. Aver-

age processing divides into ‘number average’ and ‘time average.’ 

2. When you specify as, no average processing, all the channels conduct 

sample processing. 

3. The designation of average processing is as follows. 

2MLF-AD8A 

BIT Description 

00 Sampling 

01 Time average 
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2MLF-AD16A 

BIT Description 

00 Sampling 

01 Time average 

10 Count average 

11 Weighted average 

Specifying average value 

2MLF-AD8A: Average value (Addresses 5~12) 

1. Setting range of average value is as follows. 

a) Time average setting range: 16 ~ 16000ms 

b) Count average setting range: 2 ~ 64000times 

c) Weighted average setting range: 1 ~ 99% 

2. If the specified value exceeds the range, the address that displays the error 

code shows the following signals. 

a) Exceeds the time average range: error code #50 
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b) Exceeds the number average range: error code 60# 

c) Exceeds the weighted average range: error code 70$ 

At this time, the default of average process will be applied and calculated. (# at error 

code means channel where error occurs.) 

3. Time/Count/Weighted average process value setting is as follows. 

Address Details 

Address No.5 Sets the average processing value of channel 0 

Address No.6 Sets the average processing value of channel 1 

Address No.7 Sets the average processing value of channel 2 

Address No.8 Sets the average processing value of channel 3 

Address No.9 Sets the average processing value of channel 4 

Address No.10 Sets the average processing value of channel 5 

Address No.11 Sets the average processing value of channel 6 

Address No.12 Sets the average processing value of channel 7 

2MLF-AD16A: Address Value (Addresses 9~24) 

1. Setting range of average value is as follows. 

a) Time average setting range: 16 ~ 16000ms 

b) Count average setting range: 2 ~ 64000times 

c) Weighted average setting range: 1 ~ 99% 

2. If the specified value exceeds the range, the address that displays the error 

code shows the following signals. 
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a) Exceeds the time average range: error code 60# 

b) Exceeds the number average range: error code 70# 

c) Exceeds the weighted average range: error code 80# 

At this time, the default of average process will be applied and calculated. (# at 

error code means channel where error occurred.) 

3. Time/Count/Weighted average process value setting is as follows. 

Address Details 

Address No.9 CH0 digital output value 

Address No.10 CH1 digital output value 

Address No.11 CH2 digital output value 

Address No.12 CH3 digital output value 

Address No.13 CH4 digital output value 

Address No.14 CH5 digital output value 

Address No.15 CH6 digital output value 

Address No.16 CH7 digital output value 

Address No.17 CH8 digital output value 

Address No.18 CH9 digital output value 

Address No.19 CH10 digital output value 

Address No.20 CH11 digital output value 

Address No.21 CH12 digital output value 

Address No.22 CH13 digital output value 
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Address Details 

Address No.23 CH14 digital output value 

Address No.24 CH15 digital output value 

Error codes 

2MLF-AD8A: Address No. 13 

1. Error codes detected from analog input module will be saved. 

13. The type and descriptions of the errors are as follows. 

For the details on the error codes, see the table below. 

Error Code 

(Dec) 
Description 

RUN LED 
Status 

0 Normal Run RUN LED On 

11 Module error (ASIC RAM or Register Error). RUN LED 
flashes every 
0.2s 20 Module error (A/D Conversion Error). 

40## 
Module error (Offset value with the range of 4 ~ 20mA is set greater 
than or equal to Gain value.) 

RUN LED 
flashes every 
second 

41## 
Module error (Offset value with the range of 0 ~ 20mA is set greater 
than or equal to Gain value.) 

42## 
Module error (Offset value with the range of 1 ~ 5V is set greater 
than or equal to Gain value.) 

43## 
Module error (Offset value with the range of 0 ~ 5V is set greater 
than or equal to Gain value.) 

44## 
Module error (Offset value with the range of 0 ~ 10V is set greater 
than or equal to Gain value.) 
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45## 
Module error (Offset value with the range of -10 ~ 10V is set greater 
than or equal to Gain value.) 

50## Time average setting range exceeded. 

60## Count average setting range exceeded. 

70## Weight average setting range exceeded. 

# at error code means channel where error occurred. For more details on error 

codes, refer Error codes. 

1. If there are two or more errors, the module saves the error code that occurred 

first and does not save the other error codes. 

14.   If there is an error, you should use the error clear request flag (see Error clear re-

quest flag (UXY.19.0, X: base number, Y: slot number)) or turn the power supply 

Off → On after the error is corrected so that the LED stops flashing and the error 

code is deleted. 

2MLF-AD16A: Address No. 25 

1. Error codes detected from Analog input module will be saved. 

15. The type and descriptions of the errors are as follows. 

For the details of the error codes, see the table below. 

Error Code 

(Dec) 
Description 

RUN LED 
status 

0 Normal Run On 

11 Module error (ASIC RAM or Register Error). 
Flickers every 
0.2s. 

20 Module error (A/D Conversion Error). 

1## 
Module error (Offset value with the range of 4 ~ 20mA is set greater 
than or equal to Gain value.) 

Flickers every
second 
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Error Code 

(Dec) 
Description 

RUN LED 
status 

2## 
Module error (Offset value with the range of 0 ~ 20mA is set greater 
than or equal to Gain value.) 

3## 
Module error (Offset value with the range of 1 ~ 5V is set greater 
than or equal to Gain value.) 

4## 
Module error (Offset value with the range of 0 ~ 5V is set greater 
than or equal to Gain value.) 

5## 
Module error (Offset value with the range of 0 ~ 10V is set greater 
than or equal to Gain value.) 

6## 
Module error (Offset value with the range of -10 ~ 10V is set greater 
than or equal to Gain value.) 

7## Time average setting range exceeded. 

8## Count average setting range exceeded. 

9## Weight average setting range exceeded. 

# at error code means channel where error occurred. For more details on error 

codes, refer Error codes. 

1. If there are two or more errors, the module saves the error code that occurred 

first and does not save the other error codes. 

16.   If there is an error, you should use the error clear request flag (see Error clear re-

quest flag (UXY.19.0, X: base number, Y: slot number)) or turn the power supply 

Off → On after the error is corrected so that the LED stops flashing and the error 

code is deleted. 

Hold last value 

1. If you enable this function, when input value exceeds the effective range, holds the 

last value. For example, in case of 4~20mA, if input signal change from 10mA to 

3mA, channels holds output value corresponding to 10mA. 

2. If this function is enabled, channel indicates digital output value within effect-

ive range. For effective range, refer to Characteristics of I/O conversion. 

3. This function is available in the following input range. 

• 4 ~ 20mA 
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• 0 ~ 20mA 

4. Setting is as follows. 

2MLF-AD8A: Address 14 

BIT Description 

0 Disable 

1 Enable 

2MLF-AD16A: Address 26 

BIT Description 

0 Disable 

1 Enable 

5.4 Global variable (data area) 

How to use global variable 

There are two ways to register a global variable. 

• Automatic registration after I/O parameter setting at project window 

• Batch registration after I/O parameter setting 
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For automatic registration and batch registration, refer to section Registering

special/communication module variables. 

Local variable registration 

You can register the variables as local variables among registered global 

variables. 

To register local variables in I/O parameter, perform the following steps. 

Step Action 
1 In the Project Window, double-click Local Variables under Scan Program. 

2 Right-click in the local variable window and click Add EXTERNAL variable. 

3 Select local variable to add at Global View in Add External Variable window 
(All or Base, slot). 

• View All: 



5. Configuration and Functions of the Internal Memory 
5.4. Global variable (data area) 

Step Action 

114 Analog Input Module 2MLF-AD8A, AD16A User's Guide 
Honeywell 

R210 
June 2022 

• View per base, slot: 

4 The following is example for selecting digital input value (_0403_CH0_DATA) 
of Base04, Slot03. 
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Step Action 

How to use local variable 

This section describes the how to add a global variable at local program. 

The following is an example for getting the conversion value of CH0 of analog 

input module to %MW0. 

Step Action 

1 Double-click on the variable before IN in the area where the A/D conversion 
data is read as %MW0 by using the MOVE function below and invoke the 
variable selection window. 

2 Select global variable as variable type in Select Variable window. And, also 
select relevant base (0 base, 0 slot) at global variable view item. 
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3 Double-click or select _0000_CH0_DATA corresponding to CH0 A/D 
conversion data and click OK. 

4 The following figure is the result of adding global variable corresponding to 
CH0 A/D conversion value. 
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5.5 PUT/GET function block area (parameter area) 

2MLF-AD8A 

Table 9 describes the operating parameter setting area of the analog input module. 

Table 9 - Operating parameter setting ranges 

Global Variable Contents Instruction 

_Fab_AVG_SEL1 

_Fab_CH_EN 

Average process method 

Channel to use 

PUT 

_Fab_CH0_AVG_VAL 

_Fab_CH1_AVG_VAL 

_Fab_CH2_AVG_VAL 

_Fab_CH3_AVG_VAL 

_Fab_CH4_AVG_VAL 

_Fab_CH5_AVG_VAL 

_Fab_CH6_AVG_VAL 

_Fab_CH7_AVG_VAL 

CH0 average value 

CH1 average value 

CH2 average value 

CH3 average value 

CH4 average value 

CH5 average value 

CH6 average value 

CH7 average value 

PUT 

_Fab_DATA_TYPE 

_Fab_IN_RANGE1 

_Fab_IN_RANGE2 

Output data type 

Input current/voltage range setting 1 

Input current/voltage range setting 2 

PUT 

_Fab_ERR_CODE Error code GET 

_Fab_HOLD_LV Hold last value PUT 

Where, a : means base number 

b : means slot number where the module is installed. 
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2MLF-AD16A 

Table 10 describes the operation parameter setting area of analog input module. 

Table 10 - Operation parameter setting area 

Global Variable 

Contents Instruction 

_Fab_AVG_SEL1 

_Fab_AVG_SEL2 

_Fab_CH_EN 

Average process method setting 1 

Average process method setting 2 

Enable CH 

PUT 

_Fab_CH0_AVG_VAL 

_Fab_CH1_AVG_VAL 

_Fab_CH2_AVG_VAL 

_Fab_CH3_AVG_VAL 

_Fab_CH4_AVG_VAL 

_Fab_CH5_AVG_VAL 

_Fab_CH6_AVG_VAL 

_Fab_CH7_AVG_VAL 

_Fab_CH8_AVG_VAL 

_Fab_CH9_AVG_VAL 

_Fab_CH10_AVG_VAL 

_Fab_CH11_AVG_VAL 

_Fab_CH12_AVG_VAL 

_Fab_CH13_AVG_VAL 

_Fab_CH14_AVG_VAL 

_Fab_CH15_AVG_VAL 

CH0 average value 

CH1 average value 

CH2 average value 

CH3 average value 

CH4 average value 

CH5 average value 

CH6 average value 

CH7 average value 

CH8 average value 

CH9 average value 

CH10 average value 

CH11 average value 

CH12 average value 

CH13 average value 

CH14 average value 

CH15 average value 

PUT 

_Fab_DATA_TYPE1 

_Fab_DATA_TYPE2 

_Fab_IN_RANGE1 

Output data type setting 1 

Output data type setting 2 

Input current/voltage range setting 1 

PUT 



5. Configuration and Functions of the Internal Memory 
5.5. PUT/GET function block area (parameter area) 

R210 
June 2022 

Analog Input Module 2MLF-AD8A, AD16A User's Guide 
Honeywell 

119 

Global Variable Contents Instruction 

_Fab_IN_RANGE2 

_Fab_IN_RANGE3 

_Fab_IN_RANGE4 

Input current/voltage range setting 2 

Input current/voltage range setting 3 

Input current/voltage range setting 4 

_Fab_ERR_CODE Error code GET 

At the device allocation, a means base number and b means slot number where the 

module is installed. 

PUT instruction 

*ANY: WORD, DWORD, INT, USINT, DINT, UDINT type available among ANY 

type. 

Function 
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Read data from designated special module. 

Function Block Input(ANY) Type Description 

PUT_WORD WORD 
Save WRD data into the designated module address 
(MADDR). 

PUT_DWORD DWORD 
Save DWORD data into the designated module address 
(MADDR). 

PUT_INT INT 
Save INT data into the designated module address 
(MADDR). 

PUT_UINT UINT 
Save UNIT data into the designated module address 
(MADDR). 

PUT_DINT DINT 
Save DINT data into the designated module address 
(MADDR). 

PUT_UDINT UDINT 
Save UDINT data into the designated module address 
(MADDR). 
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GET instruction 

*ANY: WORD, DWORD, INT, UINT, DINT, UDINT type available among ANY type. 

Function 

Read data from designated special module. 

Function Block Output(ANY) Type Description 

GET_WORD WORD 
Read data as much as WORD from the 
designated module address (MADDR). 

GET_DWORD DWORD 
Read data as much as DWORD from the 
designated module address (MADDR). 

GET_INT INT 
Read data as much as INT from the designated 
Module address (MADDR). 
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GET_UINT UINT 
Read data as much as UNIT from the designated 
module address (MADDR). 

GET_DINT DINT 
Read data as much as DINT from the designated 
module address (MADDR). 

GET_UDINT UDINT 
Read data as much as UDINT from the 
designated module address (MADDR). 

Example using PUT/GET instruction 

1. Enable channel 

a) You can enable/disable A/D conversion per channel. 

b) You can reduce the conversion cycle for each channel by blocking conver-

sion of the unused channel. 

c) When channel is not designated, all channels are set as not used. 

d) Enable/disable of A/D conversion is as follows: 

e) The value in B4~B15 is ignored. 

f) The above illustration on the right is example for enabling CH0~CH1 of A/

D module equipped at slot 0. 

2. Input voltage/current range setting 

a) You can set input voltage/current range per channel. 

b) When analog input range is not set, all channels are set as 1 ~ 5V (4 ~ 20mA). 
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c) Setting of analog input voltage/current range is as follows. The following is an 

example for setting CH0~CH1 as 1~5V and CH2~CH3 as 0~10V. 

3. Out put data range setting 

a) Digital output data range about analog input can be set per channel. 

b) When output data range is not set, all channels are set as -32000~32000 

for 2MLF-AD16A and 0~16000 for 2MLF-AD8A. 

c) Setting of digital output data range is as follows. 

Precise value has the following digital output range for analog input range. 

• Current 
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Analog Input 

Digital Output 

4 ~ 20mA 0 ~ 20mA 

Precise Value 4000 ~ 20000 0 ~ 20000 

• Voltage 

Analog Input 

Digital Output 

-10 ~ 10V 0 ~ 10V 0 ~ 5V 1 ~ 5V 

Precise Value 
-10000 ~ 
10000 

0 ~ 10000 0 ~ 5000 1000 ~ 5000 

4. Average process setting 

2MLF-AD8A: 

a) You can set allow/block average processing for each channel. 

b) When no average processing is designated, all channels conduct 

sampling processing. 

c) The designation of average processing is as follows. The following illustra-

tion is an example when time average is used for channel 1. 

2MLF-AD16A: 

a) You can enable/disable filter process per channel. 
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b) Filter process is not set, all channels are set as enable. 

c) Setting for filter process is as follows. The following figure is an example 

for using filter for CH4. 

5. Designation of average values 

2MLF-AD8A: 

a) The initial value of the average designation range is 0. 

b) The setting range of the average designation is as follows. 

Average Method Setting Range 

Time average 16 ~5000ms 

Count average 2 ~ 64000times 

Weighted average 1 ~ 99% 

c) When a value beyond the range is designated, the error number displays in 

the error code display (_F0001_ERR_CODE). Then the A/D conversion 

value remains the previous data. (# refers to the channel where the error 

occurred.) 

d) The setting average is as follows. 
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At the device allocation, a means base number and b means slot number where the 

module is installed. 

Address Details 

Address 5 Designates the average processing value of channel 0 

Address 6 Designates the average processing value of channel 1 

Address 7 Designates the average processing value of channel 2 

Address 8 Designates the average processing value of channel 3 

Address 9 Designates the average processing value of channel 4 

Address 10 Designates the average processing value of channel 5 

Address 11 Designates the average processing value of channel 6 

Address 12 Designates the average processing value of channel 7 
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TIP 

When you designate the time/number average processing values, set 
average processing as ‘Allow’ in advance. As for average processing, choose
between time average and number average. 

2MLF-AD16A: 

a) Initial value of filter constant is 0. 

b) Setting range of filter constant is as follows. 

Average Method Setting Range 

Time average 16 ~16000ms 

Count average 2 ~ 64000times 

Weighted average 1 ~ 99% 

c) When setting a value other than setting range, it indicates error number at 

error code indication (_F0001_ERR_CODE). Then A/D conversion value 

keeps previous data (# means the channel where error occurs at error code). 

d) Setting of filter constant is as follows. 
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Address Details 

9 CH0 average process value setting 

10 CH1 average process value setting 

11 CH2 average process value setting 

12 CH3 average process value setting 

13 CH4 average process value setting 

14 CH5 average process value setting 

15 CH6 average process value setting 

16 CH7 average process value setting 

17 CH8 average process value setting 

18 CH9 average process value setting 

19 CH10 average process value setting 

20 CH11 average process value setting 

21 CH12 average process value setting 

22 CH13 average process value setting 

23 CH14 average process value setting 

24 CH15 average process value setting 

Range is different according to average process method 

At the device allocation, a means base number and b means slot number where the module is installed. 

TIP 

Before you set time/count average value, enable the average process and 
select average method (Time/Count). 

6. Error code 

2MLF-AD8A: 

a) It saves the error code detected in the analog input module. 
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b) The type and descriptions of errors are as follows. The following illustration is 

an example of reading the error code. 

At the error code, # means the channel where the error occurred. 

For details of the error codes, refer to Error codes. 

a) If there are two or more errors, the module saves the error code that 

occurred first and does not save the subsequent error codes. 

b) If there is an error, you should use the error clear request flag (see Error 

clear request flag (UXY.19.0, X: base number, Y: slot number)) or turn the 

power supply Off → On after the error is corrected so that the LED stops 

flashing and the error code is deleted. 

2MLF-AD16A: 

a) It saves the error code detected at analog input module. 

b) Error type and contents are as follows. The following figure is pro-

gram example for reading error code. 
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At error code, # indicates channel where error occurred. 

For more detail on error code, refer to Error codes. 

a) In case two error codes occur, module saves first occurred error code 

and subsequent occurred error code is not saved. 

b) In case error occurs, after modifying error, use error clear request flag (refer 

to Error clear request flag (UXY.19.0, X: base number, Y: slot number)), 

restart power to delete error code and and LED stops flickering. 
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6. Programming 

6.1 Basic program 

• It describes about operating condition details of analog input module’s internal

memory. 

• Analog input module is installed on Slot 2. 

• I/O assigned points of analog input module is 16 points (fixed type). 

• Initial value specified is saved on the internal memory of analog input module 

under the initial setting condition. 

Program example using [I/O Parameter] 

2MLF-AD8A 
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For 2MLK 

For 2MLI/2MLR 

*Please look at ‘PUT/GET function block area (parameter area)’ 
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2MLF-AD16A 

For 2MLI / 2MLR 
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* Please look at ‘PUT/GET function block area (parameter area)’ 
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Program example using PUT/GET instruction 

2MLF-AD8A 

For 2MLK   

For 2MLI/2MLR 
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2MLF-AD16A 
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6.2 Read/Write of operation parameters setting area 

Read of operation parameters setting area (GET, GETP instruction) 

2MLF-AD16A 

Type Description Area Available 

n1 Slot No. where the special module is installed. Integer 

n2 Start address of setting area of special module’s Run parameters to 
read data. 

Integer 

D Device’s start address with saved data to read. M, P, K, L, T, C, D, #D 

n3 Number of words data to read. Integer 

Difference between GET instruction and GETP instruction: 

• GET: always executed with execution condition On ( ) 

• GETP: executed with execution condition of operation start ( ) 

Example: If analog input module is installed on Base No.0 and Slot No.3, and internal 

memory addresses No.0 and 1’s data in analog input module is read as D0 and D1 of

CPU module. 
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6.2. Read/Write of operation parameters setting area 

Write of operation parameters setting area (PUT, PUTP instruction) 

2MLF-AD16A 

Type Description Area available 

n1 Slot No. where the special module is installed. Integer 

n2 Start address of special module’s internal memory to write data. Integer 

S Device’s start address with saved data to write. M, P, K, L, T, C, D, #D 

n3 Number of words data to write. Integer 

Difference between PUT instruction and PUTP instruction: 

• PUT: always executed with execution condition On ( ) 

• PUT P: executed with execution condition of operation start ( ) 

Example: If analog input module is installed on Base No.0 and Slot No.6, and CPU 

module’s data of D10~D13 is written on internal memory addresses 7~10 of analog input 

module. 
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6.3 Application Program 

Program to sort A/D conversion values (I/O slot fixed point allocation: 64 points) 

2MLF-AD8A 

1. System configuration 

2. Initial setting 

No. Item Initial Setting 
Internal 
Memory 
Address 

Values to Write in 
Internal Memory 

1 Channel in use 
channel 0, channel 2, 
channel 4 

0 ‘h0015’ or ‘21’ 

2 Input range -10 ~ 10V 1, 2 ‘hFFFF’ or ‘65535’ 

3 
Output data 
range 

0 ~ 16000 3 ‘h0000’ or ‘0’ 

4 
Average 
processing 

channel 2: count average 

channel 4: time average 
4 ‘h0120’ or ‘288’ 

5 Average 

channel 2 count average: 
100 times 

7 ‘h0064’ or ‘100’ 

channel 4 time average: 
200ms 

9 ‘h00C8’ or ‘200’ 

3. Program description 

a) If CH 0’s digital value is less than 12000, Contact No.0 (P00080) of relay 

output module installed on Slot No.2 will be On. 

b) If CH 2’s digital value is greater than 13600, Contact No.2 (P00082) of 

relay output module installed on Slot No.2 will be On. 
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c) If CH 4’s digital value is greater than or equal to 12000 and less than or equal

to 13600, Contact No.4 (P00086) of relay output module installed on Slot 

No.2 will be On. 

d) If CH 4’s digital value is equal to 13600, Contact No.5 (P00085) of 

relay output module installed on Slot No.2 will be On. 

4. Program 

a) Program example using I/O Parameter setting. 

b) Program example using PUT/GET instruction. 
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2MLF-AD16A 

1. System configuration, same as 2MLF-AD8A, for more information, 2MLF-AD8A 

2. Initial setting, same as 2MLF-AD8A, for more information, 2MLF-AD8A 

3. Program description, same as 2MLF-AD8A, for more information, 2MLF-AD8A 

4. Program 

a) Program example using I/O Parameter setting. 
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b) Program example using PUT/GET instruction. 



6. Programming 
6.3. Application Program 

144 Analog Input Module 2MLF-AD8A, AD16A User's Guide 
Honeywell 

R210 
June 2022 
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Program that outputs the error code of the analog input module through BCD 
display 

2MLF-AD8A 

1. System configuration 

2. Initial setting 

a) Channel in use: channel 0 

b) Analog input current range: DC 4 ~ 20mA 

c) Time average processing: 100ms 

d) Digital output data range: 0 ~ 16000 

3. Program description 

a) Initial setting of A/D conversion when P00000 is On. 

b) The A/D conversion value and error code saved in D00000 and D00001 

respectively when P00001 is On. 

c) The error code is displayed in the digital BCD display when P00002 is On 

(P00040 ~ P0004F). 

4. Program 

a) Program example using I/O Parameter setting. 
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b) Program example using PUT/GET instruction. 
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2MLF-AD16A 

1. System configuration 

2. Initial setting 

a) Channel in use: channel 0 

b) Analog input current range: DC 4 ~ 20mA 

c) Time average processing: 100ms 

d) Digital output data range: 0 ~ 16000 

3. Program description 

a) If P00000 is On, A/D conversion will be initially specified. 
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b) If P00001 is On, A/D converted value and error code will be 

saved, respectively, on D00000 and D00001. 

c) If P00002 is On, applicable error code will be output to digital BCD 

display. (P00040 ~ P0004F). 

4. Program 

a) Program example using I/O Parameter setting. 

b) Program example using PUT/GET instruction. 
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7.1 Error codes 

7. Troubleshooting 

Detailed diagnostic information on error codes are given below: 

Errors which occur when A/D conversion module’s RUN LED blinks are as described in

Table 11 and Table 12. 

Table 11 - List of error codes – 2MLF-AD8A 

Error Code 

(Dec) 
Description 

RUN LED 
Status 

10 Module error (ASIC Reset Error). 

Flickers every 
0.2s. 11 Module error (ASIC RAM or Register Error). 

20 Module error (A/D Conversion Error). 

40## 
Module error (Offset value with the range of 4 ~ 20mA is set greater 
than or equal to Gain value.) 

Flickers every
1s. 

41## 
Module error (Offset value with the range of 0 ~ 20mA is set greater 
than or equal to Gain value.) 

42## 
Module error (Offset value with the range of 1 ~ 5V is set greater 
than or equal to Gain value.) 

43## 
Module error (Offset value with the range of 0 ~ 5V is set greater 
than or equal to Gain value.) 

44# 
Module error (Offset value with the range of 0 ~ 10V is set greater 
than or equal to Gain value.) 

45# 
Module error (Offset value with the range of -10 ~ 10V is set greater 
than or equal to Gain value.) 

50# Time average setting range exceeded. 

60# Number average setting range exceeded. 

70# Weighted average setting range exceeded. 
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7. Troubleshooting 

Table 12 - List of error codes – 2MLF-AD16A 

Error Code 

(Dec) 
Description 

RUN LED 
Status 

10 Module error (ASIC Reset Error). 

Flickers every 
0.2s. 

11 Module error (ASIC RAM or Register Error). 

20 Module error (A/D Conversion Error). 

30 Module error (EEPROM Error). 

1## 
Module error (Offset value with the range of 4 ~ 20mA is set greater 
than or equal to Gain value.) 

Flickers every
1s. 

2## 
Module error (Offset value with the range of 0 ~ 20mA is set greater 
than or equal to Gain value.) 

3## 
Module error (Offset value with the range of 1 ~ 5V is set greater 
than or equal to Gain value.) 

4## 
Module error (Offset value with the range of 0 ~ 5V is set greater 
than or equal to Gain value.) 

5## 
Module error (Offset value with the range of 0 ~ 10V is set greater 
than or equal to Gain value.) 

6## 
Module error (Offset value with the range of -10 ~ 10V is set greater 
than or equal to Gain value.) 

7## Time average setting range exceeded. 

8## Count average setting range exceeded. 

9## Weight average setting range exceeded. 
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7.1. Error codes 

ATTENTION 

1. # of the error code means the channel where the error occurred 

2. If two or more errors occur, the module saves only the first error code. 

3. When the error is found and corrected, use the ‘flag to request error
clear’. For more information, refer to Error clear request flag (UXY.19.0,
X: base number, Y: slot number); or restart the unit. This stops the 
blinking LED and has the unit ready to detect the next error code. 
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7. Troubleshooting 
7.2. Troubleshooting 

7.2 Troubleshooting 

RUN LED blinks 

Table 13 - Error code for 2MLF-AD8A 

Error Code 

(Dec) 
Error Details Action 

40# 

Module Offset/Gain error 

Hardware failure of analog input module. 

Turn the power ON/OFF. If the error recurs, it is 
likely that the module is defective. Contact the 
nearest Honeywell agency or branch office. 

41# 

42# 

43# 

44# 

45# 

50# Time average setting 
range exceeded 

Change time average setting value within 4 ~ 
16000. 

60# 
Number average setting 
range exceeded 

Change number average setting value within 2 ~ 
64000. 

70# 
Weight average setting 
range exceeded 

Change frequency average setting value within 1 
~ 99. 

# of the error code means the channel where the error occurred. 
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Table 14 - Error code for 2MLF-AD16A 

Error Code 

(Dec) 
Error Details Action 

1## 

2## 

3## 

4## 
Module Offset/Gain error 

Turn the power ON/OFF. If the error recurs, it is 
likely that the module is defective. Contact the 
nearest Honeywell agency or branch office. 

5## 

6## 

7## Time average setting 
range exceeded 

Change time average setting value within 16 ~ 
16000. 

8## 
Count average setting 
range exceeded 

Change number average setting value within 2 ~ 
64000. 

9## 
Weight average setting 
range exceeded 

Change frequency average setting value within 1 
~ 99. 

# of the error code means the channel where the error occurred. 
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RUN LED is Off 
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CPU module cannot read A/D conversion value 

Mismatch between analog input value and digital output value 
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Hardware error of analog input module 

Status check of analog input module using System Monitor menu 

Module type, module information, O/S version, and module status of A/D 

conversion module can be checked through SoftMaster system monitoring function. 

For more details, refer to Special module monitoring functions. 
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8. Appendix 

8.1 Appendix 1: Terminology 

Terms and abbreviation used in the user’s guide and the analog module in general are as

described below. 

A/D Converter Converts analog input signal (voltage or current) to a proportional 
digital output value (raw count). 

Analog Input 
Module 

The module that converts analog voltage/current input signal to 
proportional digital value. It has a resolution of 14 and 16 bits 
depending on the converter used. 

Channel The inputs to A/D converters are connected through channels. Each 
voltage or current input is on a different channel. Every analog input 
module will have many channels (typically 8 ~ 16). Thus, channel 
represents the circuitry used to connect input or output to an A/D or 
(D/A) converter. 

Conversion 
time 

Time taken by analog input module to sample and convert the 
analog input signal (one channel) into digital output value. Similarly, 
this term is also used to indicate the time required for analog output 
module to convert the digital value into an analog output signal and 
transmitted to the output channel. 

D/A converter Converts digital value to a proportional analog output signal (voltage 
or current, respectively). 

Full Scale The maximum value of the analog input (voltage or current) that can 
be converted by an A/D. 

Full Scale Error Difference between expected analog-converted value (voltage or 
current) and actual analog-converted value. 

Full Scale 
Range 

Difference between the maximum and the minimum value of the 
analog input (voltage or current). 

LSB (Least 
Significant Bit) 

The bit unit that gives minimum value (used in digital 
representation). 
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8. Appendix 
8.1. Appendix 1: Terminology 

Linearity Error Analog I/O is related to continuous voltage/current value and digital 
value. The acceptable I/O value is defined as a line within a distance 
of the minimum 1LSB of voltage/current. I/O linearity error is 
regarded as the deviation between the acceptable-converted value 
and the actual-converted value on the graph. See the following 
figure. 

Multiplexer A switching circuit where many signals share one A/D converter or 
D/A converter. 

Analog Output 
Module 

A module with output circuit to convert digital value from the process 
to analog output (voltage/current). 

Resolution The minimum value recognizable by a measuring instrument, which 
is usually displayed in the engineering unit (1mV) or the number of 
bits. So when there are 14 bits, 16383 output values can be 
generated. 

Filter Filters are used to avoid sudden changes in the digital value output 
caused either by external noise or sudden change in the analog 
input signal. Two types of filters used are: S/W and H/W filters. 

Accuracy Displays the maximum deviation between acceptable value and 
output value (voltage or current) for the full range of output. It also 
indicates the maximum deviation between acceptable value and 
digitally-converted input signal value for the full range of input. 
Generally, accuracy is displayed as percentage of the full scale 
value. Gain, offset, and linearity errors are all listed in the error 
codes generated. 

Output 
accuracy 

The difference between the actual analog output voltage/current 
value and the acceptable-converted value is indicated as percentage 
of full scale. It takes into account the effect of temperature, offset, 
gain, and drift error factors. 
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8. Appendix 
8.2. Appendix 2: External dimensions 

8.2 Appendix 2: External dimensions 

External dimensions of 2MLF-AD8A 
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